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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.

Details

Product Status Active

Number of LABs/CLBs 11500

Number of Logic Elements/Cells 92000

Total RAM Bits 4526080

Number of I/O 380

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 672-BBGA

Supplier Device Package 672-FPBGA (27x27)

Purchase URL https://www.e-xfl.com/product-detail/lattice-semiconductor/lfe3-95ea-6lfn672i

Email: info@E-XFL.COM Address: Room A, 16/F, Full Win Commercial Centre, 573 Nathan Road, Mongkok, Hong Kong

https://www.e-xfl.com/product/pdf/lfe3-95ea-6lfn672i-4485532
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Figure 2-1. Simplified Block Diagram, LatticeECP3-35 Device (Top Level)

PFU Blocks 
The core of the LatticeECP3 device consists of PFU blocks, which are provided in two forms, the PFU and PFF. 
The PFUs can be programmed to perform Logic, Arithmetic, Distributed RAM and Distributed ROM functions. PFF 
blocks can be programmed to perform Logic, Arithmetic and ROM functions. Except where necessary, the remain-
der of this data sheet will use the term PFU to refer to both PFU and PFF blocks. 

Each PFU block consists of four interconnected slices numbered 0-3 as shown in Figure 2-2. Each slice contains 
two LUTs. All the interconnections to and from PFU blocks are from routing. There are 50 inputs and 23 outputs 
associated with each PFU block. 
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Figure 2-8. Clock Divider Connections

Clock Distribution Network 
LatticeECP3 devices have eight quadrant-based primary clocks and eight secondary clock/control sources. Two 
high performance edge clocks are available on the top, left, and right edges of the device to support high speed 
interfaces. These clock sources are selected from external I/Os, the sysCLOCK PLLs, DLLs or routing. These clock 
sources are fed throughout the chip via a clock distribution system. 

Primary Clock Sources 
LatticeECP3 devices derive clocks from six primary source types: PLL outputs, DLL outputs, CLKDIV outputs, ded-
icated clock inputs, routing and SERDES Quads. LatticeECP3 devices have two to ten sysCLOCK PLLs and two 
DLLs, located on the left and right sides of the device. There are six dedicated clock inputs: two on the top side, two 
on the left side and two on the right side of the device. Figures 2-9, 2-10 and 2-11 show the primary clock sources 
for LatticeECP3 devices.

Figure 2-9. Primary Clock Sources for LatticeECP3-17
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Figure 2-31. MULTADDSUBSUM Slice 1

Advanced sysDSP Slice Features
Cascading
The LatticeECP3 sysDSP slice has been enhanced to allow cascading. Adder trees are implemented fully in sys-
DSP slices, improving the performance. Cascading of slices uses the signals CIN, COUT and C Mux of the slice.

Addition
The LatticeECP3 sysDSP slice allows for the bypassing of multipliers and cascading of adder logic. High perfor-
mance adder functions are implemented without the use of LUTs. The maximum width adders that can be imple-
mented are 54-bit.

Rounding
The rounding operation is implemented in the ALU and is done by adding a constant followed by a truncation oper-
ation. The rounding methods supported are:

• Rounding to zero (RTZ)

• Rounding to infinity (RTI)

• Dynamic rounding

• Random rounding

• Convergent rounding 
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Figure 2-33. Input Register Block for Left, Right and Top Edges

Output Register Block 
The output register block registers signals from the core of the device before they are passed to the sysI/O buffers. 
The blocks on the left and right PIOs contain registers for SDR and full DDR operation. The topside PIO block is the 
same as the left and right sides except it does not support ODDRX2 gearing of output logic. ODDRX2 gearing is 
used in DDR3 memory interfaces.The PIO blocks on the bottom contain the SDR registers but do not support 
generic DDR. 

Figure 2-34 shows the Output Register Block for PIOs on the left and right edges. 

In SDR mode, OPOSA feeds one of the flip-flops that then feeds the output. The flip-flop can be configured as a 
Dtype or latch. In DDR mode, two of the inputs are fed into registers on the positive edge of the clock. At the next 
clock cycle, one of the registered outputs is also latched.

A multiplexer running off the same clock is used to switch the mux between the 11 and 01 inputs that will then feed 
the output.

A gearbox function can be implemented in the output register block that takes four data streams: OPOSA, ONEGA, 
OPOSB and ONEGB. All four data inputs are registered on the positive edge of the system clock and two of them 
are also latched. The data is then output at a high rate using a multiplexer that runs off the DQCLK0 and DQCLK1 
clocks. DQCLK0 and DQCLK1 are used in this case to transfer data from the system clock to the edge clock 
domain. These signals are generated in the DQS Write Control Logic block. See Figure 2-37 for an overview of the 
DQS write control logic.

Please see TN1180, LatticeECP3 High-Speed I/O Interface for more information on this topic.

Further discussion on using the DQS strobe in this module is discussed in the DDR Memory section of this data 
sheet.
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Figure 2-40. SERDES/PCS Quads (LatticeECP3-150)

Table 2-13. LatticeECP3 SERDES Standard Support

Standard
Data Rate 

(Mbps)
Number of 

General/Link Width Encoding Style

PCI Express 1.1 2500 x1, x2, x4 8b10b

Gigabit Ethernet 1250, 2500 x1 8b10b

SGMII 1250 x1 8b10b

XAUI 3125 x4 8b10b

Serial RapidIO Type I,
Serial RapidIO Type II,
Serial RapidIO Type III

1250,
2500,
3125

x1, x4 8b10b

CPRI-1,
CPRI-2,
CPRI-3,
CPRI-4

614.4,
1228.8,
2457.6,
3072.0

x1 8b10b

SD-SDI
(259M, 344M)

1431,
1771, 
270,
360,
540

x1 NRZI/Scrambled

HD-SDI
(292M)

1483.5,
1485 x1 NRZI/Scrambled

3G-SDI
(424M)

2967,
2970 x1 NRZI/Scrambled

SONET-STS-32 155.52 x1 N/A

SONET-STS-122 622.08 x1 N/A

SONET-STS-482 2488 x1 N/A

1. For slower rates, the SERDES are bypassed and CML signals are directly connected to the FPGA routing.
2. The SONET protocol is supported in 8-bit SERDES mode. See TN1176 Lattice ECP3 SERDES/PCS Usage Guide for more information.
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Table 2-16. Selectable Master Clock (MCCLK) Frequencies During Configuration (Nominal)

Density Shifting 
The LatticeECP3 family is designed to ensure that different density devices in the same family and in the same 
package have the same pinout. Furthermore, the architecture ensures a high success rate when performing design 
migration from lower density devices to higher density devices. In many cases, it is also possible to shift a lower uti-
lization design targeted for a high-density device to a lower density device. However, the exact details of the final 
resource utilization will impact the likelihood of success in each case. An example is that some user I/Os may 
become No Connects in smaller devices in the same package. Refer to the LatticeECP3 Pin Migration Tables and 
Diamond software for specific restrictions and limitations.

MCCLK (MHz) MCCLK (MHz) 

10

2.51 13

4.3 152

5.4 20

6.9 26

8.1 333

9.2

1. Software default MCCLK frequency. Hardware default is 3.1 MHz.
2. Maximum MCCLK with encryption enabled.
3. Maximum MCCLK without encryption.

http://www.latticesemi.com/dynamic/index.cfm?fuseaction=view_documents&document_type=32&sloc=01-01-00-10
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DC Electrical Characteristics
Over Recommended Operating Conditions

Symbol Parameter Condition Min. Typ. Max. Units

IIL, IIH
1, 4 Input or I/O Low Leakage 0  VIN  (VCCIO - 0.2 V) — — 10 µA

IIH
1, 3 Input or I/O High Leakage (VCCIO - 0.2 V) < VIN  3.6 V — — 150 µA

IPU I/O Active Pull-up Current 0  VIN  0.7 VCCIO –30 — –210 µA

IPD I/O Active Pull-down Current VIL (MAX)  VIN  VCCIO 30 — 210 µA

IBHLS Bus Hold Low Sustaining Current VIN = VIL (MAX) 30 — — µA

IBHHS Bus Hold High Sustaining Current VIN = 0.7 VCCIO –30 — — µA

IBHLO Bus Hold Low Overdrive Current 0  VIN  VCCIO — — 210 µA

IBHHO Bus Hold High Overdrive Current 0  VIN  VCCIO — — –210 µA

VBHT Bus Hold Trip Points 0  VIN  VIH (MAX) VIL (MAX) — VIH (MIN) V

C1 I/O Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 8 pf

C2 Dedicated Input Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 7 pf

1. Input or I/O leakage current is measured with the pin configured as an input or as an I/O with the output driver tri-stated. It is not measured 
with the output driver active. Bus maintenance circuits are disabled. 

2. TA 25 oC, f = 1.0 MHz.
3. Applicable to general purpose I/Os in top and bottom banks.
4. When used as VREF, maximum leakage= 25 µA.
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LatticeECP3 Supply Current (Standby)1, 2, 3, 4, 5, 6

Over Recommended Operating Conditions

Symbol Parameter Device

Typical

Units–6L, –7L, –8L –6, –7, –8

ICC Core Power Supply Current

ECP-17EA 29.8 49.4 mA

ECP3-35EA 53.7 89.4 mA

ECP3-70EA 137.3 230.7 mA

ECP3-95EA 137.3 230.7 mA

ECP3-150EA 219.5 370.9 mA

ICCAUX Auxiliary Power Supply Current

ECP-17EA 18.3 19.4 mA

ECP3-35EA 19.6 23.1 mA

ECP3-70EA 26.5 32.4 mA

ECP3-95EA 26.5 32.4 mA

ECP3-150EA 37.0 45.7 mA

ICCPLL PLL Power Supply Current (Per PLL)

ECP-17EA 0.0 0.0 mA

ECP3-35EA 0.1 0.1 mA

ECP3-70EA 0.1 0.1 mA

ECP3-95EA 0.1 0.1 mA

ECP3-150EA 0.1 0.1 mA

ICCIO Bank Power Supply Current (Per Bank)

ECP-17EA 1.3 1.4 mA

ECP3-35EA 1.3 1.4 mA

ECP3-70EA 1.4 1.5 mA

ECP3-95EA 1.4 1.5 mA

ECP3-150EA 1.4 1.5 mA

ICCJ JTAG Power Supply Current All Devices 2.5 2.5 mA

ICCA
Transmit, Receive, PLL and 
Reference Clock Buffer Power Supply

ECP-17EA 6.1 6.1 mA

ECP3-35EA 6.1 6.1 mA

ECP3-70EA 18.3 18.3 mA

ECP3-95EA 18.3 18.3 mA

ECP3-150EA 24.4 24.4 mA

1. For further information on supply current, please see the list of technical documentation at the end of this data sheet.
2. Assumes all outputs are tristated, all inputs are configured as LVCMOS and held at the VCCIO or GND.
3. Frequency 0 MHz.
4. Pattern represents a “blank” configuration data file.
5. TJ = 85 °C, power supplies at nominal voltage.
6. To determine the LatticeECP3 peak start-up current data, use the Power Calculator tool.
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, 2Derating Timing Tables
Logic timing provided in the following sections of this data sheet and the Diamond and ispLEVER design tools are 
worst case numbers in the operating range. Actual delays at nominal temperature and voltage for best case pro-
cess, can be much better than the values given in the tables. The Diamond and ispLEVER design tools can provide 
logic timing numbers at a particular temperature and voltage.

18x18 Multiply/Accumulate (Input & Output Registers) 200 MHz

18x18 Multiply-Add/Sub (All Registers) 400 MHz

1. These timing numbers were generated using ispLEVER tool. Exact performance may vary with device and tool version. The tool uses inter-
nal parameters that have been characterized but are not tested on every device.

2. Commercial timing numbers are shown. Industrial numbers are typically slower and can be extracted from the Diamond or ispLEVER soft-
ware.

3. For details on -9 speed grade devices, please contact your Lattice Sales Representative.

Register-to-Register Performance1, 2, 3

 Function –8 Timing Units
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Figure 3-8. Generic DDRX1/DDRX2 (With Clock Center on Data Window)
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Table 3-11. Periodic Receiver Jitter Tolerance Specification

Description Frequency Condition Min. Typ. Max. Units

Periodic 2.97 Gbps 600 mV differential eye — — 0.24 UI, p-p 

Periodic 2.5 Gbps 600 mV differential eye — — 0.22 UI, p-p 

Periodic 1.485 Gbps 600 mV differential eye — — 0.24 UI, p-p 

Periodic 622 Mbps 600 mV differential eye — — 0.15 UI, p-p 

Periodic 150 Mbps 600 mV differential eye — — 0.5 UI, p-p

Note: Values are measured with PRBS 27–1, all channels operating, FPGA Logic active, I/Os around SERDES 
pins quiet, voltages are nominal, room temperature.
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Figure 3-14. Jitter Transfer – 3.125 Gbps

Figure 3-15. Jitter Transfer – 2.5 Gbps
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Figure 3-16. Jitter Transfer – 1.25 Gbps

Figure 3-17. Jitter Transfer – 622 Mbps
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XAUI/Serial Rapid I/O Type 3/CPRI LV E.30 Electrical and Timing 
Characteristics
AC and DC Characteristics
Table 3-13. Transmit

Over Recommended Operating Conditions

Table 3-14. Receive and Jitter Tolerance

Over Recommended Operating Conditions

Symbol Description Test Conditions Min. Typ. Max. Units

TRF Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
2, 3, 4 Output data deterministic jitter — — 0.17 UI

JTX_TJ
1, 2, 3, 4 Total output data jitter — — 0.35 UI

1. Total jitter includes both deterministic jitter and random jitter.
2. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Values are measured at 2.5 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz 
to 3.125 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz 
to 3.125 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
1, 2, 3 Deterministic jitter tolerance (peak-to-peak) — — 0.37 UI

JRX_RJ
1, 2, 3 Random jitter tolerance (peak-to-peak) — — 0.18 UI

JRX_SJ
1, 2, 3 Sinusoidal jitter tolerance (peak-to-peak) — — 0.10 UI

JRX_TJ
1, 2, 3 Total jitter tolerance (peak-to-peak) — — 0.65 UI

TRX_EYE Receiver eye opening 0.35 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 2.5 Gbps.
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Switching Test Conditions
Figure 3-33 shows the output test load that is used for AC testing. The specific values for resistance, capacitance, 
voltage, and other test conditions are shown in Table 3-23. 

Figure 3-33. Output Test Load, LVTTL and LVCMOS Standards

Table 3-23. Test Fixture Required Components, Non-Terminated Interfaces

Test Condition R1 R2 CL Timing Ref. VT

LVTTL and other LVCMOS settings (L -> H, H -> L)   0 pF

LVCMOS 3.3 = 1.5V —

LVCMOS 2.5 = VCCIO/2 —

LVCMOS 1.8 = VCCIO/2 —

LVCMOS 1.5 = VCCIO/2 —

LVCMOS 1.2 = VCCIO/2 —

LVCMOS 2.5 I/O (Z -> H)  1M 0 pF VCCIO/2 —

LVCMOS 2.5 I/O (Z -> L) 1 M  0 pF VCCIO/2 VCCIO

LVCMOS 2.5 I/O (H -> Z)  100 0 pF VOH - 0.10 —

LVCMOS 2.5 I/O (L -> Z) 100  0 pF VOL + 0.10 VCCIO

Note: Output test conditions for all other interfaces are determined by the respective standards.

DUT 

VT

R1

R2

 

CL* 

Test Point

*CL Includes Test Fixture and Probe Capacitance
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 LatticeECP3 Family Data Sheet
Pinout Information

Signal Descriptions 
Signal Name I/O Description 

General Purpose

P[Edge] [Row/Column Number]_[A/B] I/O 

[Edge] indicates the edge of the device on which the pad is located. Valid 
edge designations are L (Left), B (Bottom), R (Right), T (Top). 

[Row/Column Number] indicates the PFU row or the column of the device on 
which the PIC exists. When Edge is T (Top) or B (Bottom), only need to spec-
ify Column Number. When Edge is L (Left) or R (Right), only need to specify 
Row Number.

[A/B] indicates the PIO within the PIC to which the pad is connected. Some of 
these user-programmable pins are shared with special function pins. These 
pins, when not used as special purpose pins, can be programmed as I/Os for 
user logic. During configuration the user-programmable I/Os are tri-stated 
with an internal pull-up resistor enabled. If any pin is not used (or not bonded 
to a package pin), it is also tri-stated with an internal pull-up resistor enabled 
after configuration. 

P[Edge][Row Number]E_[A/B/C/D] I These general purpose signals are input-only pins and are located near the 
PLLs.

GSRN I Global RESET signal (active low). Any I/O pin can be GSRN. 

NC — No connect. 

RESERVED — This pin is reserved and should not be connected to anything on the board.

GND — Ground. Dedicated pins. 

VCC — Power supply pins for core logic. Dedicated pins. 

VCCAUX — Auxiliary power supply pin. This dedicated pin powers all the differential and 
referenced input buffers. 

VCCIOx — Dedicated power supply pins for I/O bank x. 

VCCA —
SERDES, transmit, receive, PLL and reference clock buffer power supply. All 
VCCA supply pins must always be powered to the recommended operating 
voltage range. If no SERDES channels are used, connect VCCA to VCC.

VCCPLL_[LOC] — General purpose PLL supply pins where LOC=L (left) or R (right).

VREF1_x, VREF2_x — Reference supply pins for I/O bank x. Pre-determined pins in each bank are 
assigned as VREF inputs. When not used, they may be used as I/O pins. 

VTTx — Power supply for on-chip termination of I/Os.

XRES1 — 10 kOhm +/-1% resistor must be connected between this pad and ground. 

PLL, DLL and Clock Functions

[LOC][num]_GPLL[T, C]_IN_[index] I General Purpose PLL (GPLL) input pads: LUM, LLM, RUM, RLM, num = row 
from center, T = true and C = complement, index A,B,C...at each side. 

[LOC][num]_GPLL[T, C]_FB_[index] I Optional feedback GPLL input pads: LUM, LLM, RUM, RLM, num = row from 
center, T = true and C = complement, index A,B,C...at each side. 

[LOC]0_GDLLT_IN_[index]2 I/O General Purpose DLL (GDLL) input pads where LOC=RUM or LUM, T is True 
Complement, index is A or B.

[LOC]0_GDLLT_FB_[index]2 I/O Optional feedback GDLL input pads where LOC=RUM or LUM, T is True 
Complement, index is A or B.

PCLK[T, C][n:0]_[3:0]2 I/O Primary Clock pads, T = true and C = complement, n per side, indexed by 
bank and 0, 1, 2, 3 within bank. 
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-70EA

Pin Type 484 fpBGA 672 fpBGA 1156 fpBGA

Emulated Differential 
I/O per Bank

Bank 0 21 30 43

Bank 1 18 24 39

Bank 2 8 12 13

Bank 3 20 23 33

Bank 6 22 25 33

Bank 7 11 16 18

Bank 8 12 12 12

High-Speed Differential I/
O per Bank

Bank 0 0 0 0

Bank 1 0 0 0

Bank 2 6 9 9

Bank 3 9 12 16

Bank 6 11 14 16

Bank 7 9 12 13

Bank 8 0 0 0

Total Single-Ended/
Total Differential I/O
per Bank

Bank 0 42/21 60/30 86/43

Bank 1 36/18 48/24 78/39

Bank 2 28/14 42/21 44/22

Bank 3 58/29 71/35 98/49

Bank 6 67/33 78/39 98/49

Bank 7 40/20 56/28 62/31

Bank 8 24/12 24/12 24/12

DDR Groups Bonded
per Bank1

Bank 0 3 5 7

Bank 1 3 4 7

Bank 2 2 3 3

Bank 3 3 4 5

Bank 6 4 4 5

Bank 7 3 4 4

Configuration Bank 8 0 0 0

SERDES Quads 1 2 3

1. Some DQS groups may not support DQS-12. Refer to the device pinout (.csv) file.
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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LatticeECP3 Part Number Description

LFE3 – XXX XX – X X XXXXXX  X

Grade
    C = Commercial
    I = Industrial    Logic Capacity

     17 = 17K LUTs
     35 = 33K LUTs
     70 = 67K LUTs
     95 = 92K LUTs
    150 = 149K LUTs
     Supply Voltage
     EA = 1.2 V

Speed
     6 = Slowest
     7
     8 = Fastest for LatticeECP3-17EA

1. Green = Halogen free and lead free.

Power
     Blank = Standard Power
     L = Low Power 

Package
    FTN256 = 256-ball Lead-Free ftBGA
    FN484 = 484-ball Lead-Free fpBGA
    FN672 = 672-ball Lead-Free fpBGA
    FN1156 = 1156-ball Lead-Free fpBGA
    MG328 = 328-ball Green csBGA1

Device Family
    ECP3 (LatticeECP3 FPGA + SERDES)
 

Ordering Information
LatticeECP3 devices have top-side markings, for commercial and industrial grades, as shown below:

Note: See PCN 05A-12 for information regarding a change to the top-side mark logo.

LFE3-95EA
7FN672C
Datecode

LFE3-95EA
7FN672I
Datecode

Commercial Industrial

LatticeECP3 Family Data Sheet
Ordering Information

http://www.latticesemi.com/documents/doc44912x28.pdf


7-4

Revision History
LatticeECP3 Family Data Sheet

March 2010 01.6 Architecture Added Read-Before-Write information.

DC and Switching 
Characteristics

Added footnote #6 to Maximum I/O Buffer Speed table.

Corrected minimum operating conditions for input and output differential 
voltages in the Point-to-Point LVDS table.

Pinout Information Added pin information for the LatticeECP3-70EA and LatticeECP3-
95EA devices.

Ordering Information Added ordering part numbers for the LatticeECP3-70EA and 
LatticeECP3-95EA devices.

Removed dual mark information.

November 2009 01.5 Introduction Updated Embedded SERDES features.

Added SONET/SDH to Embedded SERDES protocols.

Architecture Updated Figure 2-4, General Purpose PLL Diagram.

Updated SONET/SDH to SERDES and PCS protocols.

Updated Table 2-13, SERDES Standard Support to include SONET/
SDH and updated footnote 2.

DC and Switching
Characterisitcs

Added footnote to ESD Performance table.

Updated SERDES Power Supply Requirements table and footnotes.

Updated Maximum I/O Buffer Speed table.

Updated Pin-to-Pin Peformance table.

Updated sysCLOCK PLL Timing table.

Updated DLL timing table.

Updated High-Speed Data Transmitter tables.

Updated High-Speed Data Receiver table.

Updated footnote for Receiver Total Jitter Tolerance Specification table.

Updated Periodic Receiver Jitter Tolerance Specification table.

Updated SERDES External Reference Clock Specification table.

Updated PCI Express Electrical and Timing AC and DC Characteristics.

Deleted Reference Clock table for PCI Express Electrical and Timing 
AC and DC Characteristics.

Updated SMPTE AC/DC Characteristics Transmit table.

Updated Mini LVDS table.

Updated RSDS table.

Added Supply Current (Standby) table for EA devices.

Updated Internal Switching Characteristics table.

Updated Register-to-Register Performance table.

Added HDMI Electrical and Timing Characteristics data.

Updated Family Timing Adders table.

Updated sysCONFIG Port Timing Specifications table.

Updated Recommended Operating Conditions table.

Updated Hot Socket Specifications table.

Updated Single-Ended DC table.

Updated TRLVDS table and figure.

Updated Serial Data Input Specifications table.

Updated HDMI Transmit and Receive table.

Ordering Information Added LFE3-150EA “TW” devices and footnotes to the Commercial and 
Industrial tables.

Date Version Section Change Summary


